
Strona główna

Strona tytułowa

Spis treści

JJ II

J I

Strona 1 z 15

Powrót

Full Screen

Zamknij

Koniec

Redagowanie dokumentów w formacie LATEX za pomocą
edytora Emacs

Tomasz Przechlewski

2002

Spis treści
1. Wstęp 2

1.1. Podstawowa terminologia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.2. Obsługa Emacsa . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

2. Najważniejsze polecenia edycyjne 6
2.1. Otwierania i zamykanie Emacsa . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
2.2. Otwieranie, zapisywanie i zamykanie plików . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
2.3. Praca z wieloma plikami . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
2.4. Operacje na blokach tekstu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
2.5. Wyszukiwanie i zamiana . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
2.6. Pozostałe użyteczne polecenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

3. Redagowanie plików w formacie LATEX 10
3.1. Szybkie wpisywanie poleceń i kompilacja: tryb auctex . . . . . . . . . . . . . . . . . . . . 10
3.2. Tworzenie odsyłaczy i skorowidzów: tryb reftex . . . . . . . . . . . . . . . . . . . . . . . . 11
3.3. Sprawdzanie poprawności: tryb flyspell . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
3.4. Kontrola wersji: tryb pcl-cvs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Bibliografia 14



Strona główna

Strona tytułowa

Spis treści

JJ II

J I

Strona 2 z 15

Powrót

Full Screen

Zamknij

Koniec
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1. Wstęp

1.1. Podstawowa terminologia

Emacs może być uruchomiony zarówno w środowisku graficznym, jak i w prostym terminalu tekstowym.
W tym wprowadzeniu zakładamy, że redagujemy dokument w środowisku okienkowym, takim jak
uniksowe X Window czy któraś z wersji systemu Windows firmy Microsoft. W środowisku okienkowym
Emacs udostępnia między innymi menu oraz umożliwia uruchamianie większości poleceń za pomocą
myszy, co ułatwia rozpoczęcie pracy początkującym użytkownikom.

Redagowany dokument jest przechowywany w czasie pracy Emacsa w buforze. Każdy bufor ma
nazwę, która w przypadku bufora zawierającego plik jest identyczna z nazwą tego pliku. Aby zmiany
dokonane w buforze zostały utrwalone należy zapisać zawartość bufora do pliku. Jest to rozwiązanie
typowe dla każdego edytora, tyle tylko, że w dokumentacji innych edytorów rzadko używa się terminu
bufor, bo każdy bufor zawsze zawiera jakiś plik i jedyne o czym użytkownik musi pamiętać to otworzyć
plik i zapisać dokonane zmiany przed zakończeniem pracy. W przypadku Emacsa nie każdy bufor musi
być związany z redagowanym plikiem, stąd konieczność jawnego wprowadzenia tego terminu.

Okno edytora jest podzielone na cztery podstawowe części (por. rys. 1): na samej górze pasek
menu, poniżej okno główne zawierające redagowany dokument, wiersz trybu (modeline) i minibufor
(minibuffer).

Wiersz trybu zawiera różne informacje dotyczące redagowanego dokumentu: nazwę pliku, nazwy
trybów edycji itp. Tryb Emacsa to pewien wyspecjalizowany zestaw poleceń z reguły związany
z dokumentem określonego rodzaju (na przykład: dokument w formacie TEX, dokument HTML, program
źródłowy w języku C++, itp). Z reguły Emacs uruchamia właściwy tryb na podstawie odpowiednich
wpisów w pliku konfiguracyjnym .emacs i/lub w zależności od rozszerzenia nazwy redagowanego
pliku. Przykładowo w wierszu trybu przedstawionym na rysunku 1 napis emacs-intro.tex to nazwa
redagowanego dokumentu, (LaTeX Ref Hscr CVS Outl) to nazwy aktywnych trybów, L146 i C13 to
odpowiednio numer wiersza i kolumny, w których znajduje się kursor, 17% wskazuje jak daleko znajduje
się kursor od początku dokumentu (w tym wypadku jest to 17% całkowitej długości dokumentu).
Zawartość wiersza trybu może się różnić w innej instalacji Emacsa, gdyż wiersz ten może zostać inaczej
skonfigurowany.

Wiersz minibufora służy do komunikowania się użytkownika z edytorem (czyli jest odpowiednikiem
okna dialogowego w innych programach) i edytora z użytkownikiem (Emacs wyświetla w nim różnego



Strona główna

Strona tytułowa

Spis treści

JJ II

J I

Strona 3 z 15

Powrót

Full Screen

Zamknij

Koniec

pasek menu

okno główne

wiersz trybu

wiersz minibufora

Rysunek 1: Okno edytora Emacs

rodzaju komunikaty). Emacsowe okno dialogowe wygląda wprawdzie dużo mniej efektownie, niż
w większości innych edytorów, ale za to ma dwie niezwykle użyteczne funkcje, których tamte nie
posiadają, lub posiadają w „szczątkowym” zakresie: funkcję uzupełniania oraz historię.

1.2. Obsługa Emacsa
Posługiwanie się edytorem Emacs nie różni się od posługiwania się innym edytorem: polecenia edycyjne
mogą być uruchamiane albo za pomocą wybrania wskaźnikiem myszy odpowiedniej pozycji z menu
albo poprzez naciśnięcie kombinacji klawiszy. Istnieje także trzeci, specyficzny dla Emacsa, sposób
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w którym poszczególne polecenia są wykonywane po wpisaniu ich pełnej nazwy w wierszu minibufora,
po uprzednim naciśnięciu kombinacji M-x. Przykładowo do zakończenia pracy z programem służy
polecenie save-buffers-kill-emacs, które może być wykonane jawnie poprzez wpisanie pełnej nazwy
w wierszu minibufora (po uprzednim wciśnięciu M-x), lub przez wybranie [Exit Emacs] z menu [Files]
czy też – najczęściej i najszybciej – przez naciśnięcie kombinacji C-x C-s (za chwilę wyjaśnimy znaczenia
tego zapisu).

Kombinacje klawiszy Emacsa wymagają naciśnięcia klawisza Control lub klawisza określanego
w dokumentacji Emacsa jako Meta. Niektóre starsze komputery miały specjalny klawisz z takim właśnie
napisem. Na klawiaturach nie mających klawisza Meta używamy klawiszy Esc lub Alt. W dokumentacji
do Emacsa kombinacje klawiszy są zapisywane w następujący skrótowy sposób: C-x oznacza wciśnięcie
klawisza Control i wciśnięcie klawisza x (bez zwalniania Control, czyli jednocześnie). Podobnie M-x
oznacza kombinację z klawiszem Meta (realizowaną za pomocą klawisza Esc lub Alt).

Jeżeli jako klawisz Meta jest zdefiniowany klawisz Alt, to sposób wykonania kombinacji jest
analogiczny do tego, w którym posługujemy się klawiszem Control. Jeśli natomiast klawiszem Meta
jest Esc, to sposób wykonywania kombinacji jest inny, typowy dla działania klawisza Esc: naciśnij i puść
klawisz Esc a potem naciśnij drugi klawisz.

Wiele poleceń Emacsa wymaga dwóch kombinacji z klawiszami Control i/lub Meta. Przykładowo
C-x C-s oznacza naciśnięcie klawisza Control, a następnie (cały czas wciskając Control) klawiszy x po
czym s. Kombinacje zawierające jednocześnie klawisz Control i Meta występują stosunkowo rzadko.
Jeżeli jako Meta na klawiaturze działa klawisz Esc, to taką kombinację realizuje się następująco:
naciskamy i zwalniamy Esc, naciskamy Control i klawisz kombinacji.

Kombinacje klawiszy są pogrupowane w ten sposób, że wszystkie rozpoczynające się identycznym
skrótem należą do podobnej kategorii poleceń. Na przykład wszystkie skróty klawiszowe zaczynające się
kombinacją C-c są specyficzne dla trybów, tj. ustawień zależnych od typu redagowanego pliku. Oznacza
to, że ten sam skrót może mieć różne znaczenie w zależności od trybu, w którym jest wykonany, lub
może nie być wcale zdefiniowany w jakimś trybie. Polecenia zaczynające się od C-x są poleceniami
podstawowymi i są jakby „wbudowane” w Emacsa, co oznacza, że mają to samo znaczenie niezależnie od
trybu, w którym są użyte. Polecenia zaczynające się kombinacją C-h rozpoczynają przeglądane systemu
pomocy Emacsa; wreszcie kombinacja M-x umożliwia wpisania polecenia w wierszu minibufora.

Ten ostatni sposób pracy może się wydać beznadziejnie wolny zwłaszcza zważywszy na fakt,
że polecenia Emacsa z reguły są okropnie długie (wspomniane na początku punktu polecenie
save-buffers-kill-emacs nie należy do najdłuższych). Tak jednak nie jest, ponieważ przy wpisywaniu
w minibuforze poleceń i innych tekstów wspomagają użytkownika funkcje uzupełniania i historii. Uzupeł-
nianie dla przypomnienia polega na tym, że po wpisaniu początku napisu i naciśnięciu znaku Tab, reszta



Strona główna

Strona tytułowa

Spis treści

JJ II

J I

Strona 5 z 15

Powrót

Full Screen

Zamknij

Koniec

jest uzupełniana pod warunkiem oczywiście, że podany początek jednoznacznie określa całość. Jeżeli
tak nie jest, można dopisać kilka następnych liter i powtórnie nacisnąć Tab. Przykładowo aby wykonać
polecenie save-buffers-kill-emacs można wcisnąć M-x, wpisać sa i nacisnąć Tab a Emacs uzupełni
napis w minibuforze do save-. Po dopisaniu b znowu naciskamy Tab i napis zostanie uzupełniony do
save-buffer. Teraz można nacisnąć jeszcze raz Tab a Emacs odpowie dopisując: „[Complete but not
unique]”, co oznacza, że wiele poleceń rozpoczyna się od save-buffer. Można w tym momencie naci-
snąć s, a można też wcisnąć Tab drugi raz z rzędu. W tym drugim przypadku ekran zostanie podzielony
(por. rys 2) a w dolnej połówce zostanie wyświetlone zestawienie wszystkich poleceń rozpoczynających
się od save-buffer (w specjalnym buforze o nazwie *Completions*). Teraz można albo wskazać o co
nam chodzi myszą (środkowy przycisk), albo dopisać brakujący koniec w nazwie polecenia. Po wybraniu
polecenia dolne okno zostanie zamknięte automatycznie.

Rysunek 2: Zestawienie poleceń rozpoczynających się od save-bufer
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Historia z kolei pozwala przywołać, zmienić i uruchomić powtórnie wykonane wcześniej polecenia.
Naciśnięcie znaku strzałki w górę przywoła poprzednie polecenia, zaś strzałki w dół następne.
Strzałki lewo/prawo oraz klawisz Backspace umożliwiają zmianę polecenia przed jego powtórnym
uruchomieniem. Emacs rejestruje wiele różnych zdarzeń, tak więc historia nie odnosi się wyłącznie
do wydawania poleceń.

2. Najważniejsze polecenia edycyjne

2.1. Otwierania i zamykanie Emacsa
Żeby wystartować Emacsa, należy wpisać emacs& w wierszu poleceń terminala. Emacs wykona instrukcje
zawarte w pliku .emacs, jeżeli taki plik znajduje się w katalogu domowym oraz ogólnosystemowy plik
site-start.el (lub default.el). W razie błędów w tych plikach ich wykonywanie zostanie zatrzymane
– trzeba wtedy sprawdzić co było przyczyną błędu i poprawić. Emacsa opuszczamy wciskając kombinację
C-x C-c (lub wykonując polecenie save-buffers-kill-emacs albo wybierając [Exit Emacs] z menu
[Files]).(W dalszej części wprowadzenia dla każdego opisywanego polecenia Emacsa oprócz kombinacji
klawiszy będziemy także podawać pełną nazwę polecenia odpowiadającego tej kombinacji oraz pozycję
w systemie menu, jeżeli dane polecenie jest dostępne poprzez wybór z menu. Uwaga: z trzech podanych
sposobów dialogu z Emacsem układ menu jest tym, który zmienia się najczęściej z wersji na wersję.
Opisany w tym wprowadzeniu system menu odnosi się do wersji 20.x Emacsa. W wersji 21 oraz
w XEmacsie – popularnej odmianie Emacsa – układ menu jest odmienny.)

2.2. Otwieranie, zapisywanie i zamykanie plików
Do otwarcia pliku służy kombinacja klawiszy C-x C-f (polecenie find-file lub [Files]→[Open File]). Po
uruchomieniu tego polecenia w wierszu minibufora zostaje wyświetlone zapytanie o nazwę pliku, który
ma zostać otwarty:

Find file: <katalog>

Domyślnie w minibuforze wyświetlona jest ścieżka do bieżącego katalogu. Wiersz ten może być
edytowany, można także wykorzystywać funkcję uzupełniania. Działa również przewijana klawiszami
strzałek góra/dół historia. Jeżeli naciśniemy Enter to wejdziemy do specjalnego trybu edytowania
katalogu (por. rys 3).
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Rysunek 3: Tryb edytowania katalogu

W tym trybie można wybrać plik poruszając się strzałkami lub wskazując go myszą. Naciśnięcie
Enter lub e powoduje wyświetlenie pliku w buforze, naciśnięcie v powoduje wyświetlenie pliku w trybie
podglądu (bez możliwości edycji; po naciśnięciu q nastąpi powrót do okna z zawartością katalogu).
Jeżeli naciśniemy Enter lub e ustawiając kursor na wierszu oznaczającym katalog to w buforze zostanie
wyświetlona zawartość tego katalogu. W ten sposób można „zwiedzić” cały system plików jeżeli będzie
to niezbędne do odszukania pliku, który jest nam potrzebny

Do zapisania zawartości bieżącego bufora w pliku na dysku służy kombinacja C-x C-s (save-buffer
lub [Files]→[Save Buffer]).
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2.3. Praca z wieloma plikami
Kombinacja klawiszy C-x b (switch-to-buffer) służy do zmiany bufora w bieżącym oknie na inny.
Emacs zapyta w minibuforze o nazwę bufora, który ma zostać nowym buforem bieżącym. Domyślnie
podpowiadaną nazwą jest nazwa poprzednio wyświetlanego bufora. W minibuforze działa mechanizm
uzupełnień oraz przewijana klawiszami strzałek historia. Jeżeli naciśniemy klawisz Tab, to okno zostanie
podzielona i w dolnej połówce zostanie wyświetlona lista buforów. Można albo dopisać brakującą część
nazwy (wystarczy tyle żeby nazwa była unikatowa, po czym można nacisnąć Tab) i nacisnąć Enter lub
nacisnąć środkowy klawisz myszy wskazując na odpowiednią nazwę bufora.

Kombinacja klawiszy C-x C-b (list-buffers lub [Buffers]→[List All Buffers]) powoduje podzielenie
okna na pół i wyświetlenie w jednym z okien listy buforów. Wreszcie menu [Buffers] zawiera listę
buforów; możliwe jest wybranie innego bufora poprzez proste wskazanie myszą na odpowiednią nazwę
w tym menu.

Emacs potrafi podzielić okno na wiele części. W osobnych oknach możliwe jest przeglądanie różnych
plików lub tego samego pliku. Podzielenie okna w taki sposób, że jedno znajduje się nad drugim realizuje
kombinacja C-x 2 (split-window-vertically lub [Files]→[Split Window]); zaś w taki sposób, że jedno
jest obok drugiego – kombinacja C-x 3 (split-window-horizontally).

Naciśnięcie C-x 1 (delete-other-window lub [File]→[One Window]) spowoduje zamknięcie wszyst-
kich okien oprócz okna bieżącego. Kombinacja C-x 0 (delete-window) powoduje zamknięcie bieżącego
okna, zaś kombinacja C-x o (other-window) służy do zmiany bieżącego okna na inne. Jeżeli ekran
Emacsa jest podzielony na więcej niż jedno okno to po naciśnięciu C-x o kursor zostanie umieszczony
w następnym oknie.

Często używanym poleceniem jest kombinacja C-x k (kill-buffer), która zamyka bufor. Po naci-
śnięciu C-x k w wierszu minibufora pojawi się komunikat:

Kill buffer: (default <nazwa-bufora>)

Emacs pyta o nazwę bufora, który ma zostać zamknięty (domyślnie jest to bufor bieżący; wystarczy
wtedy nacisnąć Enter). Jeżeli bufor był związany z plikiem i był modyfikowany, to Emacs upewnia się,
że zmiany mają być porzucone:

Buffer <nazwa-bufora> modified; kill anyway? (yes or no)

Na to pytanie trzeba odpowiedzieć albo yes albo no. Wpisanie y lub n nie wystarczy. Jeżeli wpiszemy
yes to wprowadzone zmiany, nie zostaną zapisane w pliku. Za pomocą kombinacji C-x k można usunąć
nie tylko bufory zawierające pliki. Tą samą sekwencją możesz też zlikwidować każdy inny bufor, na
przykład bufor zawierający komunikaty z kompilacji dokumentu TEX-owego, por. p. 3.1.
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2.4. Operacje na blokach tekstu
Początek bloku oznaczamy wciskając C-Space; koniec bloku znajduje się w miejscu kursora. Można
również zaznaczyć blok za pomocą myszy (taki blok można skopiować do innej aplikacji).

Zaznaczony blok może zostać wycięty i przesłany do schowka poprzez naciśnięcie C-w ([Edit]→[Cut]
lub kill-region), skopiowany do schowka przez naciśnięcie M-w ([Edit]→[Copy] lub copy-region) czy
też wklejony poprzez naciśnięcie C-y ([Edit]→[Paste] lub yank).

2.5. Wyszukiwanie i zamiana
Kombinacja C-s (isearch-forward) uruchamia funkcję wyszukiwania w przód. W minibuforze pojawia
się pytanie o szukany napis:

I-search:

Wyszukanie w Emacsie jest przyrostowe, tzn. Emacs nie czeka na wpisanie całego napisu, ale prze-
suwa kursor w dokumencie po podaniu każdego kolejnego znaku. Jeśli chcemy przerwać wyszukiwanie
i pozostać kursor w miejscu, w którym się znajduje należy nacisnąć Enter. Powtórne naciśnięcie C-s
przesunie kursor do następnego wystąpienia napisu. Jeżeli usuniemy znak z minibufora, to kursor zo-
stanie cofnięty w górę, w miejsce, w którym był przed dopisaniem usuniętego znaku. Szukanie w tył
realizuje polecenie C-r (isearch-backward)

Polecenie zamiany jest wywoływane kombinacją M-% (query-replace lub [Search]→[Query Replace]).
Emacs zapyta o napis, która ma być wymieniony. Po jego wpisaniu i wciśnięciu Enter, pojawi się
pytanie o napis, który ma go zastąpić. Po wpisaniu napisu i wciśnięciu Enter Emacs wyszuka pierwsze
wystąpienie napisu do wymiany i zapyta w wierszu minibufora:

Query replacing <napis-1> with <napis-2>: (? for help)

Gdzie: <napis-1> oznacza napis do wymiany a <napis-2>, to napis, który ma zastąpić <napis-1>.
Naciśnięcie y spowoduje dokonanie zmiany, naciśnięcie n poniechanie zmiany i wyszukanie następnego
wystąpienia <napisu-1>; naciśnięcie ! zamieni wszystkie pozostałe wystąpienia <napisu-1> aż do końca
bufora bez potwierdzania. Można też nacisnąć ? aby wyświetlić ekran z tekstem pomocy.

2.6. Pozostałe użyteczne polecenia
Naturalnym odruchem zakończenia wykonania omyłkowo rozpoczętego polecenia jest użycie Esc.
W Emacsie do tego celu wykorzystuje się kombinację C-g (keyboard-quit). W razie potrzeby można
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spróbować nacisnąć tę kombinację wielokrotnie. Istnieją rzadkie sytuacje kiedy C-g nie wystarczy. Dwie
inne ratunkowe kombinacje to C-] oraz trzykrotne wciśnięcie Esc. Za pomocą tych trzech sekwencji
klawiszy użytkownik jest w stanie zawsze zmusić Emacsa do wyjścia z trybu przyjmowania poleceń
i powrócenia do edycji bufora.

Kombinacja C-_ (undo lub [Edit]→[Undo]) cofa ostatnio wykonane polecenie. Można wywoływać undo
wielokrotnie, cofając kolejne operacje. Emacsowe undo nie ma ograniczeń, można cofać tak długo, aż
odtworzony zostanie stan pliku w momencie jego otwarcia.

Kolejnym użytecznym poleceniem jest przesunięcie kursora do wiersza o podanym numerze. Służy do
tego polecenie goto-line, które standardowo nie ma żadnego skrótu klawiszowego ani nie jest dostępne
w systemie menu!

3. Redagowanie plików w formacie LATEX

3.1. Szybkie wpisywanie poleceń i kompilacja: tryb auctex
Tryb auctex wspomaga redagowanie dokumentów w formacie TEX: przyśpiesza wpisywanie poleceń
i środowisk, ułatwia kompilację dokumentu czy koloruje jego składnię.

Polecenia definiujące śródtytuły wstawiamy za pomocą kombinacji klawiszy C-c C-s (LaTeX-section
lub [LaTeX]→[Section]). Auctex zapyta o poziom śródtytułu (można wybrać odpowiednią nazwę z listy
posługując się mechanizmem uzupełniania), następnie należy wpisać tytuł i ewentualnie etykietą
związaną ze śródtytułem, tj. argument LATEX-owego polecenia label.

Środowiska LATEX-a wstawiamy po naciśnięciu C-c C-e (LaTeX-environment lub [LaTeX]→[Insert
Environment]). Jeżeli polecenie realizujemy poprzez kombinację klawiszy, to w minibuforze pojawi się
pytanie o nazwę środowiska; możliwy jest wybór z listy z pomocą mechanizmu uzupełniania. Jeżeli
posługujemy się myszą to po wybraniu [LaTeX]→[Insert Environment], należy wybrać odpowiednią
pozycję z wyświetlonego okna. Przydatny jest także skrót M-Enter, który wstawia LATEX-owe polecenie
\item lub \bibitem, w zależności od kontekstu.

Kompilacja dokumentu znajdującego się w bieżącym buforze, jego zamiana na plik PostScriptowy,
sortowanie skorowidza, itp są możliwe po wybraniu z menu [Command] odpowiedniej pozycji. Do
kompilacji dokumentu w formacie LATEX należy uruchomić [Command]→[LaTeX] lub [Command]→[LaTeX
interactive]. W pierwszym przypadku kompilacja odbywa się w tle, a po jej zakończeniu w wierszu
minibufora wyświetlany jest stosowny komunikat. W drugim przypadku okno jest automatycznie dzielone
na pół; kompilacja jest wykonywana w drugim oknie a strumień komunikatów jest w nim wyświetlany
na bieżąco. Wybranie [Command]→[File] (lub [Command]→[Dvips]) zamieni plik .dvi na plik .ps
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uruchamiając w tym celu program dvips. Wybranie [Command]→[Index] spowoduje posortowanie
skorowidza (za pomocą zewnętrznego programu). Wreszcie polecenie [Command]→[LaTeX PDF] wykona
kompilację dokumentu za pomocą programu pdflatex.

Auctex współpracuje z trybem ukrywania/pokazywania fragmentów tekstu (tryb ten – jeżeli nie
jest włączony domyślnie – można włączyć wykonując polecenie outline-minor-mode). Jeżeli tryb jest
włączony, to w pasku menu znajdują się trzy dodatkowe pozycje: [Headings], [Show] i [Hide]. Menu
[Headings] zawiera polecenia przesuwania kursora po dokumencie w oparciu o strukturalne polecenia
LATEX-a, takie jak: \chapter czy \section. Menu [Hide] służy do ukrywania fragmentów dokumentu
a menu [Show] służy do pokazywania fragmentów dokumentu.

Rysunek 4 przedstawia wygląd dokumentu po wybraniu [Hide Body] z menu [Hide]. Emacs ukrywa
zawartość całego dokumentu i wyświetla tylko wiersze zawierające śródtytuły. Prawie cały dokument
zmieścił się na ekranie, ale o tym, że widzimy jedynie jego „szkielet” można się przekonać patrząc na
numer bieżącego wiersza w wierszu trybu (477).

3.2. Tworzenie odsyłaczy i skorowidzów: tryb reftex
Pakiet reftex wspomaga użytkownika w zakresie tworzenia odsyłaczy i skorowidzy. Pozwala także na
łatwą nawigację wewnątrz dokumentu. Funkcje pakietu są dostępne poprzez menu [Ref].

3.3. Sprawdzanie poprawności: tryb flyspell
Do sprawdzania poprawności ortograficznej tekstu wykorzystywany jest pakiet flyspell wykorzystujący
standardowy program ispell lub aspell. Uruchomienie tego trybu jest wykonywane za pomocą funkcji
flyspell-mode. Polecenie flyspell-buffer służy do sprawdzenie zawartości bufora. Wyrazy, które
nie znajdują się w słowniku są wyróżniane kolorem czerwonym i podkreślane. Kliknięcie środkowym
wskaźnikiem myszy na wyróżniony w ten sposób wyraz umożliwia jego poprawienie.

3.4. Kontrola wersji: tryb pcl-cvs
Podczas pracy wielu osób nad jednym dokumentem niezwykle istotne jest zapewnienie koordynacji ich
pracy. Do tego celu używa się systemów kontroli wersji, takich jest CVS. Emacs potrafi współpracować
z systemem CVS umożliwiając wykonywanie operacji na dokumencie będącym pod kontrolą systemu
z wnętrza Emacsa, bez potrzeby korzystania przez użytkownika z dodatkowych aplikacji. Emacs
dysponuje wbudowanym trybem obsługi systemu kontroli wersji dostępnym po wybraniu [Version
Control] z menu [Tools] lub dodatkowym pakietem pcl-cvs wyspecjalizowanym w obsłudze systemu
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Rysunek 4: Wygląd dokumentu po wykonaniu funkcji hide-body

CVS. Jeżeli pakiet ten jest zainstalowany, to ważniejsze funkcje dostępne są po wybraniu [Pcl cvs] z menu
[Tools]. W tym opracowaniu omówimy sposób pracy z pakietem pcl-cvs.

Jeżeli dokument jest pod kontrolą systemu CVS to Emacs sygnalizuje ten fakt w wierszu trybu dodając
napis CVS do listy trybów, por. rys 5.

Rysunek 5: Wygląd wiersza trybu dokumentu pod kontrolą systemu CVS
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Po słowie CVS występuje znak dwukropka (jeżeli dokument został po pobraniu z archiwum
zmodyfikowany) lub minus (jeżeli dokument nie został zmodyfikowany) oraz numer wersji dokumentu,
którym oznaczył go system CVS.

Wybranie [Checkout Module] z menu [Tools]→[Pcl CVS] umożliwia pobranie modułu z repozytorium.
Emacs zapyta o nazwę modułu i nazwę katalogu roboczego, pobiera moduł z repozytorium i wyświela
zawartość katalogu roboczego w specjalnym buforze o nazwie *cvs*, por. rys. 6.

Rysunek 6: Bufor przeglądania zawartości katalogu roboczego

W tym buforze możemy strzałkami przesuwać się pomiędzy poszczególnymi plikami. Naciśnięcie
? spowoduje wyświetlenie w minibuforze tekstu pomocy. Naciśnięcie s oznacza przesłanie pliku do
archiwum (submit); naciśnięcie a to dodanie nowego pliku do archiwum (add); naciśnięcie d to polecenie
wyświetlenia różnic między wersjami; naciśnięcie l to polecenie wyświetlenie pliku log; naciśnięcie r
oznacza usunięcie pliku; s to określenie statusu pliku
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W oknie wyświetlanym po wybraniu [Tools]→[Pcl CVS] znajdują się jeszcze trzy pozycje: [Update Directory],
[Examine Directory] i [Status Directory], których wybranie powoduje odpowiednio wykonanie: cvs
update, cvs -n update oraz cvs status. W każdym przypadku, po wykonaniu polecenia, Emacs wy-
świeli wynik w specjalnym formacie w opisanym wyżej buforze *cvs*.
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C-x C-b, 8
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delete-other-window, 8
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isearch-backward, 9
isearch-forward, 9

keyboard-quit, 9
kill-buffer, 8
kill-region, 9

LaTeX-environment, 10
LaTeX-section, 10
list-buffers, 8

M-%, 9
M-Enter, 10
M-w, 9

M-x, 4, 5

other-window, 8
outline-minor-mode, 11

query-replace, 9

save-buffer, 7
save-buffers-kill-emacs, 4–6
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